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Client Software License Agreement

DEFINITIONS
• “Avaya” means Avaya Inc.
• “You”, “Your”, or “Licensee” means the per-

son or business entity who purchased this 
License to use this Client Software or for 
whom such License was purchased.

• “Client Software” means a software applica-
tion that operates on a computer system 
that provides resources to Client Software.

• “Documentation” means the manual and 
any other printed material provided by 
Avaya with the Client Software.

• “License” means the License purchased 
and granted pursuant to this Agreement.

LICENSE AND PROTECTION

1. License Grant. Avaya grants to You, subject to the 
following terms and conditions, a nonexclusive, 
nontransferable right to use the Client Software on 
multiple single user devices, maximum 
simultaneous users of the Client Software being 
limited to the number Licensed and authorized by 
Avaya. THE SERVER SOFTWARE 
AUTOMATICALLY PREVENTS SIMULTANEOUS 
USE BY MORE THAN THE AUTHORIZED 
NUMBER OF USERS. Avaya reserves all rights 
not expressly granted to You.

2. Protection of Software. You agree to take all 
reasonable steps to protect the Client Software 
and Documentation from unauthorized copy or 
use. The Client Software source code represents 
and embodies trade secrets of Avaya and/or its 
licensors. The source code and embodied trade 
secrets are not licensed to You and any 
modification, addition, or deletion is strictly 
prohibited. You agree not to disassemble, 
decompile, or otherwise reverse engineer the 
Client Software in order to discover the source 
code and/or the trade secrets contained in the 
source code or for any other reason.

To the extent that the Client Software is located in 
a Member State of the European Community and 
You need information about the Client Software in 
order to achieve interoperability of an 
independently created software program with the 
Client Software, You shall first request such 
information from Avaya. Unless Avaya refuses to 
make such information available, You shall not 
take any steps, such as reverse assembly or 
reverse compilation, to derive a source code 
equivalent to the Client Software. Avaya may 
charge You a reasonable fee for the provision of 
such information.

3. Copies. You may make multiple copies of the 
Client Software, provided You do not receive any 
payment, commercial benefit, or other 
consideration for reproduction or use. You may not 
copy Documentation unless it carries a statement 

that copying is permitted. All proprietary rights 
notices must be faithfully reproduced and included 
on all copies.

4. Ownership. Ownership of, and title to, the Client 
Software and Documentation (including any 
adaptations or copies) remains with Avaya and/or 
its licensors.

5. Restrictions. You agree not to rent, lease, 
sublicense, modify or time share the Client 
Software or Documentation.

6. Termination. This Agreement shall automatically 
terminate if You breach any of the terms or 
conditions of this Agreement. You agree to destroy 
the original and all copies of the Client Software 
and Documentation, or to return them to Avaya, 
upon Termination of this License.

LIMITED WARRANTY AND LIMITED LIABILITY

1. Compatibility. The Client Software is only 
compatible with certain computers and operating 
systems. THE SOFTWARE IS NOT WARRANTED 
FOR NONCOMPATIBLE SYSTEMS.

2. Software. Avaya warrants that if the Client 
Software fails to substantially conform to the 
specifications in the Documentations and if the 
Client Software is returned to the place from which 
it was purchased within one (1) year from the date 
purchased, then Avaya will either replace the 
Client Software or offer to refund the License Fee 
to You upon return of all copies of the Client 
Software and Documentation to Avaya. In the 
event of a refund, the License shall terminate.

3. DISCLAIMER OF WARRANTIES. Avaya makes 
NO WARRANTY, REPRESENTATION OR 
PROMISE NOT EXPRESSLY SET FORTH IN 
THIS AGREEMENT. AVAYA DISCLAIMS AND 
EXCLUDES ANY AND ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. 
AVAYA DOES NOT WARRANT THAT THE 
CLIENT SOFTWARE OR DOCUMENTATION 
WILL SATISFY YOUR REQUIREMENTS OR 
THAT THE CLIENT SOFTWARE OR 
DOCUMENTATION ARE WITHOUT DEFECT OR 
ERROR OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED. Some 
states or countries do not allow the exclusion of 
implied warranties or limitations on how long an 
implied warranty lasts, so the above limitation may 
not apply to You. This warranty gives You specific 
legal rights which vary from state to state.



4. EXCLUSIVE REMEDY. EXCEPT FOR BODILY 
INJURY CAUSED BY AVAYA’S NEGLIGENCE, 
AVAYA’S ENTIRE LIABILITY ARISING FROM OR 
RELATING TO THIS AGREEMENT OR THE 
CLIENT SOFTWARE OR DOCUMENTATION 
AND YOUR EXCLUSIVE REMEDY IS LIMITED 
TO DIRECT DAMAGES IN AN AMOUNT NOT TO 
EXCEED $10,000. AVAYA SHALL NOT IN ANY 
CASE BE LIABLE FOR ANY SPECIAL 
INCIDENTAL, CONSEQUENTIAL, INDIRECT OR 
PUNITIVE DAMAGES EVEN IF AVAYA HAS 
BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. AVAYA IS NOT 
RESPONSIBLE FOR LOST PROFITS OR 
REVENUE, LOSS OF USE OF THE CLIENT 
SOFTWARE, LOSS OF DATA, COSTS OF 
RECREATING LOST DATA, THE COST OF ANY 
SUBSTITUTE EQUIPMENT OR PROGRAM, OR 
CLAIMS BY ANY PARTY OTHER THAN YOU. 
Some states or countries do not allow the 
exclusion or limitation of incidental or 
consequential damages, so the above limitation or 
exclusion may not apply to You.

GENERAL CONDITIONS.

1. Governing Law. This Agreement shall be 
governed by, and interpreted in accordance with, 
the substantive laws of the State of New Jersey of 
the United States of America.

2. Entire Agreement. This Agreement sets forth the 
entire understanding and agreement between You 
and Avaya and may be amended only in a writing 
or writings signed by You and Avaya. NO 
VENDOR, DISTRIBUTOR, DEALER, RETAILER, 
SALES PERSON OR OTHER PERSON IS 
AUTHORIZED TO MODIFY THIS AGREEMENT 
OR TO MAKE ANY WARRANTY, 
REPRESENTATION OR PROMISE WHICH IS 
DIFFERENT THAN, OR IN ADDITION TO, THE 
REPRESENTATIONS OR PROMISES OF THIS 
AGREEMENT ABOUT THE SOFTWARE.

3. Export. Licensee hereby agrees that it will not 
knowingly, directly or indirectly, without prior 
written consent, if required, of the Office of Export 
Licensing of the U.S. Department of Commerce, 
Washington D.C. 20230, export or transmit any of 
the Products to any group Q, S, W, Y, or Z country 
specified in the Export Administration Regulations 
issued by the U.S. Department of Commerce or to 
any country which such transmission is restricted 
by applicable regulations or statues.

4. U.S. Government Restricted Rights. Use, 
duplication, or disclosure by the United States 
Government is subject to restrictions as set forth in 
FAR 52.227-14 (June 1987) Alternate III (g)(3) 
(June 1987), FAR 52.227-19 (June 1987), or 
DFARS 52.227-7013 (c)(1)(ii) (June 1988), as 
applicable Contractor/Manufacturer is Avaya Inc. 
11900 North Pecos Street, Westminster, Colorado 
80234.

5. Assignment. Avaya may without your consent or 
notice to You, assign this Agreement to an entity to 
which it transfers ownership of the Client Software. 
Upon the effective date of such assignment, You 
agree that Avaya shall be released and 
discharged from all obligations and liabilities under 
this Agreement.
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About this document

This document provides instructions for the installation of the Avaya 
Visual Vectors software. Visual Vectors provides a simple graphical 
user interface to the Avaya Call Vectoring feature. Call Vectoring 
enables you to create, copy, and edit vectors on supported 
MultiVantageTM or DefinityTM switches. 

This section includes the following topics:

● Intended audience on page 7

● Reason for reissue on page 7

● Document organization

● Related documents on page 8

● How to order Avaya Publications on page 8

Intended audience

This guide is intended for individuals who install the Avaya Visual 
Vectors software. It assumes that you are familiar with the operation of 
your computer and the Microsoft Windows® operating system that is 
installed on it. Windows versions that are compatible with Visual 
Vectors include Windows 95, Windows 98, Windows 2000, Windows 
NT 4.0, Windows ME, and Windows XP. 

! Important:
Avaya does not provide technical support for Visual Vectors 
installed on Windows 95 systems. Installation of Visual Vectors 
Version 11 on Windows 95 systems is permissive. This means 
that it may be possible to install and run the Visual Vectors 
Version 11 client software on Windows 95 systems. However, 
if technical problems occur, upgrade of the client operating 
system to a fully supported Windows platform is required. 

Reason for reissue

This document is being reissued to support Avaya Visual Vectors 
Version 11.



8 Visual Vectors V11 Installation and Getting Started 

About this document

Document organization

This installation guide includes the following major topics:

● Before you begin on page 11

● Installing the Visual Vectors Server Software on page 17

● Installing Visual Vectors on client computers on page 23

● Getting started with Avaya Visual Vectors on page 35

Related documents

● Avaya Call Center R3V11 Documentation CD-ROM, 585-780-800

● Avaya Visual Vectors Version 11 User Guide, 585-210-709

● Avaya Call Management System R3V11 Software Installation, 
Maintenance, and Troubleshooting, 585-215-115

How to order Avaya Publications

By telephone:
Avaya Publications Center

Voice: 1-800-457-1235 or International Voice: 1-410-568-3680

Fax: 1-800-457-1764 or International Fax: 1-410-891-0207

By mail:
Globalware Solutions

200 Ward Hill Avenue

Haverhill, MA 01835

USA

By email:
totalware@gwsmail.com

Provide the following information in you request:

Document No. 585-210-710

Comcode No. 108502220

Issue 1, May 2002



How to order Avaya Publications

Issue 1.0 May 2002 9

You can be placed on a standing order list for this and other 
documents. If you are on the list, you will automatically receive updated 
versions of individual documents or document sets, billed to account 
information that you provide. For more information on standing orders, 
or to be put on a list to receive future issues of this document, please 
contact the Avaya Publications Center.
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About this document
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Before you begin

Read the following information before you begin a Visual Vectors 
installation:

● Visual Vectors software components on page 11

● Hardware and software requirements on page 13

● Upgrade considerations on page 14

● Using the HOME variable to maintain user-specific settings on 
page 15 

● Technical support on page 16

Visual Vectors software components

Avaya Visual Vectors is a client/server application, which means that 
software is installed on multiple computers. 

● Avaya Visual Vectors Server Software is the server component

● Avaya Visual Vectors is the client component

Visual Vectors Server Software
Visual Vectors Server Software is installed directly on a CMS server. 
The server software provides the gateway for Visual Vectors to the 
user call center network. It must be installed before Visual Vector client 
applications can make a connection to that CMS. 

For the procedure used to install the server software, see Installing the 
Visual Vectors Server Software on page 17.

Visual Vectors client
Visual Vectors is installed on client PCs, from which you can then 
access and manipulate various types of objects in your call center 
network. 
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Before you begin

Types of Visual Vectors client 
installations

There are two basic methods used to install the Visual Vectors client 
software, which are described as follows.

Visual Vectors local installation
A complete set of Visual Vector software components can be installed 
on a PC workstation or other Windows-based network server. This type 
of local installation includes all the application files needed to run 
Visual Vectors on the client.

Visual Vectors network client installation
Visual Vectors can also be installed in a shared network configuration. 
In this case, most of the application files are installed on a central, 
Windows-based computer.

One or more network client installations are then created on other 
computers on the network. The network client installations include the 
minimal set of Visual Vectors files required to link to the main 
application files on the central server share. 

The shared network installation option is useful in work environments 
where installation capacity on client PCs is limited by hardware 
configurations or company policies.



Hardware and software requirements

Issue 1.0 May 2002 13

Hardware and software requirements 

Computer systems used for Visual Vectors client installations should 
meet or exceed the following recommended system specifications.

Operating systems
Visual Vectors is supported on the following operating systems:

● Windows 98

● Windows NT (Service Pack 4.0 or later)

● Windows 2000

● Windows ME

● Windows XP

! Important:
Avaya does not provide technical support for Visual Vectors 
installed on Windows 95 systems. Installation of Visual Vectors 
Version 11 on Windows 95 systems is permissive. This means 
that it may be possible to install and run the Visual Vectors 
Version 11 client software on Windows 95 systems. However, 
if technical problems occur, upgrade of the client operating 
system to a fully supported Windows platform is required. 

Minimum recommended hardware configurations
The recommended minimum hardware configurations for the Visual 
Vectors Version 11 client software include:

● 300 MHz Pentium II (or compatible) processor 

● RAM requirements 

— Windows 98, NT and ME systems – 96 MB RAM (128 MB if co-
resident with Avaya CMS Supervisor) 

— Windows 2000 and XP systems – 128 MB RAM (160 MB if co-
Pentium II (or compatible) 300 MHz processor 

● Available free disk space

— 45 MB free space before installing Visual Vectors client software 
(90 MB free space if Supervisor will also be installed)
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Before you begin

! Important:
For each additional language included in an installation, add 
an additional 5 MB for Visual Vectors and 5 MB for Supervisor. 

● A CD-ROM drive (local client installation only)

● SVGA monitor with a graphics adapter that supports 64K colors or 
higher, and a minimum resolution of 800 x 600 pixels 

● Microsoft Internet Explorer (IE) version 3.0.2 or later 

Note:
IE is not required to be set as the default system browser to 
view html files.

● For Network connection:

— WinSock 1.1 compliant TCP/IP stack

— Ethernet communications board

Upgrade considerations

The Visual Vectors installation program detects the presence of any 
earlier versions of the software that may be installed on the computer. 
If a previous version of the software is detected, during the installation 
process, you are prompted to either upgrade the existing installation or 
preserve the existing installation and add the new version as a 
separate installation.

Special considerations for upgrading Version 1 software
If you are upgrading from an original Visual Vectors Version 1 
installation, additional upgrade measures are required. A database 
upgrade message will be displayed when you start the new Visual 
Vectors software for the first time, and you are instructed to find and 
run the migrate.bat tool, which is located in the Visual Vectors 
program directory. A detailed description of the procedure used to run 
the tool can be found in the installation readme.txt file.

If you previously chose to keep the existing Visual Vectors Version 1 
program, and then add the new version as a separate installation, you 
are also notified that the upgraded database will not be compatible with 
the Version 1 installation, and you are provided the option to cancel the 
database upgrade. Note that if you cancel the database upgrade, you 
will not be able to use the new Visual Vectors installation. 
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Using the HOME variable to maintain 
user-specific settings

Read this section if:

● the Visual Vectors application installed on a client PC will be used 
by more than one user

● it is important to preserve user-specific settings for each user

Visual Vectors creates and maintains a .cvvv directory in which to 
store user-specific application settings. User specific settings include 
items such as CMS servers to which you have established 
connections, custom scratch pads you have created, any vectors 
stored offline in your scratchpads, and so forth.

The Visual Vectors installation program searches for a user HOME 
environment variable on the computer. For each HOME variable that is 
identified, a .cvvv folder is created in the directory specified by the 
user HOME variable. If the installation program does not find one or 
more user HOME variables on the system, a single default location is 
used, and user-specific settings are not maintained. Therefore, to 
enable user-specific settings for Visual Vectors, each user login must 
be associated with a unique user HOME variable. 

! Important:
Windows operating systems allow creation of both system and 
user versions of the HOME variable. The Visual Vectors 
installation program looks only for user HOME variables to 
establish locations in which to create and maintain user-
specific .cvvv directories. 

If a user Home variable is not detected, the installation program 
prompts you to specify a file location for a new HOME variable.

Creating user HOME variables
The steps required to create HOME user variables differ for various 
Windows operating systems versions. Although, a complete 
description is beyond the scope of this installation guide, the following 
general information is provided. 

In general, environment variables in Windows are associated with the 
System Properties dialog. For example, on a Windows NT or Windows 
2000 system, select:

Start > Settings > Control Panel > System Properties
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● In the System Properties dialog on an NT system, select 
the Environment tab.

● In the System Properties dialog on a Windows 2000 
system, select the Advanced tab and click the 
Environment Variables button.

For more information on environment variables, consult with your 
system administrator, or see the user documentation for your Windows 
operating system.

Uninstalling Visual Vectors

If you want to uninstall the Visual Vectors software from a client 
computer, use the Windows Add/Remove Programs utility, which is 
located in the Control Panel dialog.

Technical support

If you have difficulty installing Visual Vectors client software, refer to 
the following sources:

● The online Help application provided with the installation program. 
To launch the installation help, press the F1 function key when the 
installation program is running.

● The readme.txt file on the CD-ROM. 

● The troubleshooting section located in Avaya Visual Vectors 
Version 11 User Guide, 585-210-709. 

Note:
An electronic copy of the user guide can be found on the 
Visual Vectors Version 11 Software CD.

If you review the information sources listed above and still require 
assistance, contact one of the technical support resources described 
below:

United States customers  – Call the Avaya Customer Care Center at 
1-800-242-2121.

International customers – Contact your designated Avaya 
representative or distributor for assistance.
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Installing the Visual Vectors Server 
Software

This section describes how to install and start the Avaya Visual Vectors 
Server Software on a CMS server. Installation of the server software is 
typically performed by a CMS system administrator who has the 
necessary server permissions. 

If the Avaya Visual Vectors Server software is already installed on the 
CMS server or servers, or you are otherwise not responsible for 
installation of the server software, go to Installing Visual Vectors on 
client computers on page 23. 

Installing the Visual Vectors Server Software includes the following 
topics:

● Installation prerequisites on page 17

● Installation procedure on page 17

● Starting the Visual Vectors Server software on page 21

Installation prerequisites

Before you install the Visual Vectors server software, obtain the Avaya 
Visual Vector Server Software CD-ROM. 

Note:
The Visual Vector Server software CD-ROM is shipped 
separately from the Visual Vectors client software package. 

Installation procedure

To install the Avaya Visual Vectors Server Software:

1. Verify that you are logged in as root at the console of the CMS 
server. 

2. Load the Avaya Visual Vectors Server Software CD-ROM into the 
CD-ROM drive.
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Installing the Visual Vectors Server Software

3. After about 15 seconds, enter mount to verify the name of the 
CD-ROM.

The program displays a list of devices and file systems currently 
mounted. The last line should display information about the 
installed CD device that is similar to the following example:

4. Enter:

pkgadd -d /cdrom/cdrom0 LUfaas

If this is the first time that Visual Vectors has been installed, the 
system displays the following message: 

/cdrom/untitled on /vol/dev/dsk/c0t2d0/untitled read 
only/nosuid/maplcase/noglobal/rr/traildot/dev=16c0001 on (current 
date and time)

Processing package instance <LUfaas> from </cdrom/untitled>

Visual Vectors Server Software
(sparc) vvsXX.X

Copyright (c) 1998 Avaya Inc.
All Rights Reserved

The selected base directory </cms/aas> must exist before 
installation is attempted.

Do you want this directory created now [y,n,?,q]
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5. Enter: y 

The system displays the following message:

6. Enter:  y 

The system displays the following message:

7. Enter: y

The system displays the following message: 

Using </cms/aas> as the package base directory.

## Processing package information.
## Processing system information.
## Verifying package dependencies.
## Verifying disk space requirements.
## Checking for conflicts with packages already installed.

The following files are already installed on the system and are 
being used by another package:

* /cms/aas <attribute change only>
* - conflict with a file which does not belong to any package.

Do you want to install these conflicting files [y,n,?,q]

## Checking for setuid/setgid programs.

This package contains scripts which will be executed with super-
user permission during the process of installing this package.

Do you want to continue with the installation of <LUfaas> [y,n,?]

Installing Visual Vectors Server Software as <LUfaas>

## Installing part 1 of 1.
/cms/aas/.odbc.ini
/cms/aas/AAS_README
/cms/aas/Translation/AcdRelease/de_DE
..........
..........
..........
Installation of <LUfaas> was successful.
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Installing the Visual Vectors Server Software

8. Enter: 

setupaas

The system displays the Avaya Visual Vectors System Services 
Menu.  

9. Enter the number associated with the init_vvs option.

The system displays the following message:

10. Enter the number of allowable concurrent logins, which must not 
exceed the number of licenses that were purchased. 

11. Enter:

eject cdrom

For the procedure used to start the software, see Starting the Visual 
Vectors Server software on page 21.

Avaya Visual Vectors Server System Services Menu

Select a command from the list below.

1) init_vvs     Setup the initial configuration
2) run_vvs      Turn VVS on or off
3) auth_display Display simultaneous VVS logins
4) auth_set     Change simultaneous VVS logins
5) backup       Backup vector steps and layout files
6) restore      Restore vector steps and layout files

Enter choice (1-6) or q to quit:

This version of VVS functions only with CMS.

CMS name used : cms3
Maximum concurrent VVS logins[1-100](q to quit):
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Starting the Visual Vectors Server 
software 

To start the Avaya Visual Vectors Server software:

1. Stop and restart AOM:

a. Enter: aom stop

b. Enter: aom start

2. Enter: 

setupaas

The system displays the Avaya Visual Vectors System Services 
Menu.

3. Enter the number associated with the run_vvs option. 

The system displays the following message:

4. Enter the number associated with the Turn VVS On option.

Avaya Visual Vectors Server System Services Menu

Select a command from the list below.

1) init_vvs     Setup the initial configuration
2) run_vvs      Turn VVS on or off
3) auth_display Display simultaneous VVS logins
4) auth_set     Change simultaneous VVS logins
5) backup       Backup vector steps and layout files
6) restore      Restore vector steps and layout files

Enter choice (1-6) or q to quit:

1) Turn VVS On
2) Turn VVS Off

Enter choice (1-2) or q to quit:
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Installing the Visual Vectors Server Software
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Installing Visual Vectors on client 
computers

Installing Visual Vectors on client computers describes the installation 
options available for Visual Vectors. Topics include: 

● Visual Vectors installation options on page 23

● Setting up a network installation folder on page 24

● Installing the main application files on page 25

● Creating a network client installation on page 30

● Installing the Avaya Visual Vectors Training program on page 33

Visual Vectors installation options

You can install Avaya Visual Vectors on client computers by either of 
two basic methods. The different installation types are described as 
follows.:

● Local client installation

● Shared network client installations

Local client installation
A local installation of Visual Vectors includes all of the software 
components that Visual Vectors needs to connect to the Visual Vectors 
Server Software on CMS servers. 

A local installation can be created from:

● The product CD-ROM.

● A network installation folder that is available over the local area 
network. The Visual Vectors installation files are copied from the 
product CD into a directory on a Windows-based server that is 
connected to the local area network. This type of installation is 
convenient when access to the product CD-ROM is limited. For 
more information, see Setting up a network installation folder on 
page 24.
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Shared network client installations
Visual Vectors can be set up to work in a shared network environment, 
in which one or more Visual Vectors client computers link to a common 
set of application files that have been installed on a central Windows-
based server. The client computers include a minimal set of 
components that are required to connect to the application files 
installed on the central server, from which the application is remotely 
run. 

The shared network installation option is useful in work environments 
where installation capacity on client PCs is limited by hardware 
configurations or company policies.

Setting up a network installation 
folder

You can copy the Visual Vectors installation program files onto a 
computer connected to your local area network, from which they can 
be used to create either local or shared network installations. This is a 
useful strategy if access to the Visual Vectors product CD-ROM is 
limited.

Note:
If availability of the Visual Vectors product CD-ROM is not a 
concern, and you do not want to create a network installation 
folder, go to Installing the main application files on page 25.

Procedure
To create a network installation folder for the Visual Vectors installation 
program:

1. Load the Avaya Visual Vectors CD-ROM on a computer that can 
be accessed over your local area network. 

! Important:
If AutoPlay is enabled on the computer, the Visual Vectors 
installation program starts after you insert the CD-ROM into 
the drive. If the installation program begins, select Cancel. 

2. Open the Windows Explorer application and create a new folder 
to hold the Visual Vectors installation files. 

Tip:
Remember to record the folder file path for future reference. 
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3. Select the drive assigned for the computer CD-ROM device and 
copy the main Visual Vectors installation directory to the folder 
you created in Step 2.

4. Verify that client computers on which you want to install Visual 
Vectors can make a network connection to the server that 
contains the network installation folder. If necessary, request 
assistance from your system administrator.

Installing the main application files

This section includes the following topics:

● Basic installation types on page 25

● Prerequisites on page 25

● Procedure on page 26

Basic installation types
You can create either of the following types of Visual Vectors 
installations:

● A local, stand-alone installation 

● A shared network installation, in which the application is installed on 
a central network server, from which it can be run by one or more 
remote client computers

Note:
If you create a shared network installation, you also need to 
create one or more network client installations to run from the 
shared network application files. 

For more information, about the shared network installation option, see 
Visual Vectors client on page 11. 

For a description of the procedure used to create the client 
installations, see Creating a network client installation on page 30.

Prerequisites
Before you begin the installation process:

● You must be logged in to the client system with an account that has 
administrator privileges.

● If you want to install Visual Vectors directly from the product 
CD-ROM, obtain the Avaya Visual Vectors Version 11 CD-ROM. 
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● If you want to install Visual Vectors from a network installation folder 
that you have previously set up, obtain the file path for the network 
folder. For more information, see Setting up a network installation 
folder on page 24.

● If more than one user will use Visual Vectors on the computer, verify 
that a unique HOME user variable has been created for each user 
login. For more information, see Using the HOME variable to 
maintain user-specific settings on page 15.

Procedure
To install the main Visual Vectors application files:

1. Choose between the following options:

● If installing from the CD-ROM – Insert the CD-ROM in the 
computer CD-ROM device. 

— If the CD-ROM AutoPlay feature is enabled on your 
computer, the Visual Vectors setup program starts 
automatically.

— If AutoPlay is not enabled, open Windows Explorer, select 
the local drive associated with the CD-ROM file and run 
the Setup.exe file. Alternately, you can select Start > Run 
from the Windows desktop, and enter the path to 
setup.exe. For example if the CD-ROM device is assigned 
to the local D: drive, you would enter the following path:

D:\\setup.exe

● If installing from a network installation folder – Use 
Windows Explorer to navigate to the network drive on which the 
network installation folder is located. In the network folder, 
select the setup.exe file. 

The first Visual Vectors installation starts and the Type of Install 
dialog is displayed. 

2. In the Type of Install dialog, do the following:

a. Select either the Local or Network option.

b. Click Install

After you choose the installation type and click Install, the 
Welcome screen is displayed.

3. In the Welcome dialog, click Next.
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4. Choose an appropriate option:  

If … Then …

One or more installation 
warning messages are 
displayed 

Your computer does not meet all of the Visual 
Vectors installation requirements, such as 
browser version, service packs, supported 
platforms, and so forth. 
Complete any actions needed to satisfy 
prerequisite system requirements, and restart the 
installation procedure.

Either the Select 
Location or Select 
Network Location dialog 
is displayed

All installation requirements are met, and an 
earlier version of Visual Vectors is not installed 
on the system. Do one of the following:

a. To accept the default installation directory, 
click Next. 

b. To select or create a different installation 
directory, click Browse, select or create the 
directory you want to use for the installation 
files, and click OK. 

c. Go to Step 5.

Either an Upgrade or 
Multiple Versions dialog 
is displayed

The installation program detects a previous copy 
of Visual Vectors software on the computer.
Perform the following steps:

a. Select an installation/upgrade option (abort, 
upgrade, or install a second copy)

b. Click Next.

c. Go to Step 5.
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5. Choose between the following options:

● If you are performing a Network installation, the Ready to 
Install dialog is displayed. Click Install. 

When the Install Successful dialog is displayed, click Finish. 
The Network installation is now complete, but you must create 
one or more network client installations. Follow the procedures 
described in Creating a network client installation on page 30.

● If you are performing a Local installation, a second Type of 
Install dialog is displayed. Continue with Step 6.

6. In the Type of Install dialog, select the appropriate radio button to 
choose between the Typical and Custom options.

● Choose the Typical option if you want to install the Avaya 
Visual Vectors Help files both in English and the language of 
your operating system (if other than English). Then click Next.

● If you want to see a list from which to select the languages in 
which Avaya Visual Vectors Help files will be installed, choose 
the Custom option and click Next. 

Select the installation languages from the list that is provided 
and then click Next again.

After you specify the install type, the Select Folder dialog is 
displayed. 

7. In the Select Folder dialog, enter a folder name for the 
application shortcuts, and then click Next.

The Ready to Install dialog is displayed.

8. In the Ready to Install dialog, click Install. 
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9. Choose one of the following options:

● If the Install Successful! dialog is displayed, click Finish. 

● If the Set HOME environment dialog is displayed do the 
following:

i. Either use the Browse button to select a directory location 
for the HOME variable and click OK, or click Next to accept 
the default location specified by the installation program. 
For more information about the HOME variable, see Using 
the HOME variable to maintain user-specific settings on 
page 15.

The installation finishes and the Install Successful! dialog 
is displayed.

ii. Click Finish.

The Local installation is complete.

Note:
The Avaya Visual Vectors CD-ROM also includes a multimedia 
Visual Vectors Training program. If you want to install the 
training program, see Installing the Avaya Visual Vectors 
Training program on page 33.
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Creating a network client installation

A network client installation sets up the client computer to run Visual 
Vectors remotely from a network server on which the main application 
files are stored. The network client setup creates a program group with 
icons on the remote clients that link to the executable files on the 
network drive.

This section includes the following topics:

● Prerequisites on page 30

● Procedure on page 30

Prerequisites
Before you begin a network client installation:

● Verify that the client computer meets the installation requirements 
listed in Hardware and software requirements on page 13.

● The client PC must be able to connect to the server on which the 
main application files were installed as a Network installation. If 
necessary, request assistance from your system administrator.

● The directory containing the Visual Vectors application files on the 
Windows-based network server must be configured as a shared 
folder. If necessary, request assistance from your system 
administrator.

● Verify that for each user who will log in and use Visual Vectors from 
a client PC, a unique HOME user variable has been created. For 
more information, see Using the HOME variable to maintain user-
specific settings on page 15.

Procedure
To perform a client setup:

1. Navigate the Windows file system and access the shared folder 
located on the network server where the Visual Vectors 
application files are installed.

2. Locate and then double-click the setupclient.exe file. 

The Welcome dialog is displayed.

3. In the Welcome dialog, click Next.
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4. Choose between the following options:

If … Then …

One or more 
installation warning 
messages are 
displayed 

Your computer does not meet all of the Visual Vectors 
installation requirements, such as browser version, 
service packs, supported platforms, and so forth.
Complete any actions needed to comply with the 
prerequisite system requirements, and restart the 
installation procedure

The Select 
Location dialog is 
displayed

All installation requirements are met, and an earlier 
version of Visual Vectors is not installed on the system. 
Do one of the following:

a. To accept the default installation directory, click 
Next. 

b. To select or create a different installation directory, 
click Browse, select or create the directory you want 
to use for the installation files, and click OK.

Result: The Ready to Install dialog is displayed.

c. Go to Step 5.

Either an Upgrade 
or Multiple 
Versions dialog is 
displayed

The installation program detects a previous copy of 
Visual Vectors software on the computer. Perform the 
following steps:

a. Select an installation/upgrade option (abort, 
upgrade, or install a second copy).

b. Click Next.

Result: The Ready to Install dialog is displayed.

c. Go to Step 5.



32 Visual Vectors V11 Installation and Getting Started 

Installing Visual Vectors on client computers

5. In the Ready to Install dialog, click Install. 

One of the following results will occur:

● The Install Successful! dialog is displayed. 

● The Set HOME environment dialog is displayed if neither a 
system HOME variable or a user HOME variable for the login 
under which the installation is being run are configured. For 
more information, see as described in Using the HOME 
variable to maintain user-specific settings on page 15. 

6. Choose one of the following options:

● If the Install Successful! dialog is displayed, click Finish. 

● If the Set HOME environment dialog is displayed do the 
following:

i. Either use the Browse button to select a directory location 
for the HOME variable and click OK, or click Next to accept 
the default location specified by the installation program.

The installation finishes and the Install Successful! dialog 
is displayed.

ii. Click Finish.

The network client installation is complete. 

Note:
The Avaya Visual Vectors CD-ROM also includes a multimedia 
Visual Vectors Training program. If you want to install the 
training program, see Installing the Avaya Visual Vectors 
Training program on page 33.
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Installing the Avaya Visual Vectors 
Training program

The Avaya Visual Vectors installation includes a multimedia training 
program that you can use to become more familiar with the application. 

Prerequisites
Before you begin to install the multimedia training program:

● Obtain the Avaya Visual Vectors CD-ROM

● Verify that you can login to the client computer with administrator 
privileges.

Procedure
To install the Visual Vectors training program:

1. Insert the Avaya Visual Vectors CD-ROM in the CD-ROM drive.

If autoplay is enabled on the system, the installation program 
begins. Cancel the installation.

2. Open Windows Explorer. In the left window pane, click on the 
drive associated with the CD-ROM device. 

The contents of the CD-ROM are displayed. 

3. Locate the folder named BT467M and double click on it to display 
its contents. 

4. Locate and double click the Setup.exe file. 

5. Follow the instructions provided by the installation program. 
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Getting started with Avaya Visual Vectors

Visual Vectors has an easy-to-use graphical user interface that lets you 
create and manage vectors quickly and easily from a workstation. 
Using Visual Vectors, you can create vectors, save the vectors to an 
ACD, edit vectors, and copy and paste vectors by using an easy drag-
and-drop method.

This section provides instructions for common application tasks:

● Starting Visual Vectors on page 36

● Connecting to a CMS server from Visual Vectors on page 37

● Using Navigator on page 39

● Using Vector Editor on page 42

● Using the VDN Assignment Wizard on page 49

● Using the Import Export Wizard on page 52

For more detailed information, see Avaya Visual Vectors Version 11 
User Guide, 585-210-709. An electronic copy of the user guide is 
included on the product CD-ROM.



36 Visual Vectors V11 Installation and Getting Started 

Getting started with Avaya Visual Vectors

Starting Visual Vectors

When you start Visual Vectors, the Avaya Visual Vectors Framework 
toolbar is displayed. You use the Framework window to:

● Connect to CMS servers

● Start Navigator, Vector Editor, VDN Assignment Wizard, and Import 
Export Wizard from the Tools menu or toolbar

● Start the Avaya CMS Supervisor program

Note:
The Avaya CMS Supervisor icon is not displayed on the 
Framework toolbar if Supervisor is not installed on the 
computer.

Procedure
To start Visual Vectors:

1. Beginning at the Windows taskbar, select Start > Programs > 
Avaya Visual Vectors.

The software program starts and the Avaya Visual Vectors 
Framework window opens. Although Visual Vectors is running, 
you are not yet connected to a CMS server.

Connect / Disconnect Navigator Vector Editor Import Export Wizard

Supervisor
VDN Assignment Wizard Avaya CMS



Connecting to a CMS server from Visual Vectors

Issue 1.0 May 2002 37

Connecting to a CMS server from 
Visual Vectors

Connecting to a CMS server from Visual Vectors includes the following 
topics:

● When a CMS server connection is required on page 37

● When a CMS server connection is not required on page 37

● Connecting to an existing server on page 38

● Connecting to a new server on page 38

● Disconnecting from a CMS server on page 39

When a CMS server connection is required 
You must connect to a server to:

● View and work with objects stored for that ACD

● Assign vector directory numbers (VDNs) to a vector

● Save your finished vector to a switch

● Import and export a vector from an ACD

! Important:
Changes to vectors do not take effect unless the link between 
the CMS server and the switch is up. If the link is not up, Visual 
Vectors gives you the option to save to another location.

When a CMS server connection is not required 
You do not need to connect to a server to:

● View vectors stored on your ScratchPad

● View names of CMS servers to which you have connected 
previously

● Create a new vector

● Edit a vector you have copied from the switch onto your ScratchPad
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Connecting to an existing server
Use this procedure if you have previously connected to the CMS 
server. 

If you have connectivity problems – If you fail to get a login prompt 
or the login attempt is denied, see the Troubleshooting section in 
Avaya Visual Vectors Version 11 User Guide. An electronic copy of the 
user guide is included on the Visual Vectors product CD-ROM.

To connect to an existing server:

1. Click Connect on the toolbar or select Connect from the File 
menu. 

The system displays the Connect to dialog. The Connect to 
server: drop-down list displays the last server to which you 
connected. You can open the list to view other CMS servers to 
which you have connected. 

2. In the Connect to dialog, do the following:

● Enter your CMS login Id in the Login Id: text box.

● Enter your CMS password in the Password: text box.

● Click Connect.

Note:
You are limited to one instance of a login ID per CMS server, 
but you can connect to more than one server at a time.

Connecting to a new server
If you have never connected to a CMS server before, you need to 
establish an initial connection. 

If you have connectivity problems – If you fail to get a login prompt 
or the login attempt is denied, see the Troubleshooting section in 
Avaya Visual Vectors Version 11 User Guide. An electronic copy of the 
user guide is included on the Visual Vectors product CD-ROM.

To connect to a new server:

1. Select New CMS from the File menu.

The New CMS login dialog box is displayed.

2. Type the hostname or IP address of a CMS server in the Server 
Network Address: text box.
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3. Enter your CMS login ID in the Login Id: text box.

4. Type your CMS password in the Password: text box.

5. Click OK.

If the CMS server you entered is found, and you have the 
appropriate user permissions, a connection is established. If the 
CMS server is not found, the system displays an error message 
showing the cause of the failure.

Note:
You are limited to one instance of a login ID per CMS server, 
but you can connect to more than one server at a time.

Disconnecting from a CMS server
To disconnect from a CMS server:

1. From the File menu:

a. Select Disconnect

The Disconnect dialog is displayed.

b. Click on server from the server list and click Disconnect.

Using Navigator

You use Navigator to view and manage call center objects. Navigator 
provides a hierarchical view of your Call Center World, similar to the 
way in which Microsoft Windows Explorer provides a hierarchical view 
of your file system. 

This section includes the following topics:

● Basic Navigator functions: on page 40

● Working with objects on page 40

● Validating vectors on page 41

● Renaming objects on page 41



40 Visual Vectors V11 Installation and Getting Started 

Getting started with Avaya Visual Vectors

Basic Navigator functions:
You can use Navigator to:

● View and manage switch objects used in vectors

● Organize objects into folders

● Copy and move vectors from an offline ScratchPad to one or more 
ACDs, and between ACDs

● Change properties of all objects

● View and rename objects, depending on your permissions

Working with objects
For practice using Navigator:

1. To open Navigator, click the Navigator icon in the Framework 
window.

2. Double-click a server name to view objects on that server.

Note:
If you are not connected to the server, Visual Vectors prompts 
you to log in. 

3. Navigator displays the server you selected, and the ACDs for 
which you have read permission. For each ACD, Navigator 
organizes objects into folders.

4. To work on a highlighted vector, you would do one of the following: 

● Double-click it to launch Vector Editor and work on it now.

● Highlight it and drag it to your ScratchPad to work on it later.

Note:
When you drag the vector, the system asks you whether you 
want to copy or move it to the appropriate ACD.
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Validating vectors
To validate a vector, you need to copy, move, or save it to the 
appropriate ACD.

A vector is valid if:

● It contains no more than 32 stored steps.

● It is complete.

● All goto steps have destinations.

● Objects to which steps refer reside on the ACD.

● The user has write permission for the vector and the ACD.

The system displays an error message if the vector is invalid and gives 
you the opportunity to fix any problems before the vector is changed.

Renaming objects
In Navigator, you use the ScratchPad to store vectors on your 
computer. If you have many vectors, organize them into folders.

You can rename objects in your Visual Vectors workspace. For 
example, you can use the following procedure to rename the Default 
ScratchPad:

1. In Navigator, click Default ScratchPad to highlight it.

2. Click the right mouse button.

The popup menu is displayed.

The context menu lists commands you can use in Navigator. 
These commands are also available from drop-down menus.

3. Select Rename from the menu.

The Renaming Default ScratchPad dialog is displayed.

4. In the Name text box, type the new name and click OK.
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Using Vector Editor

Vector Editor allows you to use a drag-and-drop feature to create and 
edit vectors. Different kinds of vector steps can be selected from a 
palette, and arranged in a work area. With the Vector Editor, you can:

● Choose vector steps from palettes.

● Add vector steps.

● Change properties of vector steps.

● Create a vector.

● Save and print the vector you created.

This section includes the following topics:

● Creating an example vector on page 42

● Saving a vector on page 47

● Printing your vector graphic on page 47

Creating an example vector
The following procedure explains briefly how to create an 
announcement vector, which plays an announcement until the caller 
reaches an agent.

To create an announcement vector:

1. To start the Vector Editor, select Vector Editor from the Tools 
menu or toolbar in the Framework window.

2. Do the following:

a. Select Tools > Vector Editor

A submenu displays a list of possible vector types, which are 
based on switch releases and their installed options.
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b. From the switch submenu, select an appropriate vector type.

The Vector Editor - New Vector window is displayed.
 

Tip:
The green light shows the vector’s starting point. You choose 
the vector steps from the palettes on the left.

Vector steps in the Input/Output palette determine which inputs 
you want to provide and which outputs customers can provide. 
The steps in the Input/Output palette include Announcement, 
Timed Announcement, Music, Ringback, Silence, Reply, 
Consider, Collect, and Converse.



44 Visual Vectors V11 Installation and Getting Started 

Getting started with Avaya Visual Vectors

3. You are going to create a new vector in which the first step is an 
announcement. In the vector step palette, click and drag the 
Announcement step (top left in the palette) into the empty box in 
the vector workspace. When the step new is positioned correctly, 
the box is highlighted in yellow. 

Tip:
You can also copy and paste steps from other vectors. This 
allows you to reuse vector steps when a step in an existing 
vector has properties you want to specify in a new vector step. 

4. Define the properties for the new Announcement step. Place the 
cursor over the step and click the right mouse button.

A popup menu is displayed. 
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5. Select Properties 

The Properties input window is displayed. 

6. To complete this window:

● In the Extension: field, enter your extension.

● In the Comments: field, enter “New welcome announcement to 
be recorded.”

A representation of a completed window is shown below:
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7. Click OK to save the changes. 

The new Announcement step in the vector workspace now 
displays the extension number you specified.

Tip:
A red triangle indicates on the corner of a step indicates that 
the step has an associated comment. Roll your cursor over it 
to view the comment.
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Saving a vector
To save a new or revised vector from the Vector Editor window:

1. From the main menu, select File > Save As... .

The Vector Editor displays the Save Vector As window.

2. Browse the My World directory to find the container in which you 
want to save the current vector.

3. Click the name of the container (ScratchPad or folder) in which 
you want to save the vector.

4. If you want to give the vector a name that is different from the 
default name, type your preferred name in the Name text box; for 
example, Holiday Announcement.

5. Click Save.

The Vector Editor does one of the following:

● Saves a graphical representation of the selected vector to the 
ScratchPad

● Converts the visual vector and stores it on the ACD containing 
the vector folder.

6. When you are finished creating a vector, you need to assign 
VDNs to the vector. For instructions, see, Using the VDN 
Assignment Wizard on page 49.

Printing your vector graphic
To print the graphic representation of a vector from Vector Editor:

1. Select File > Print 

The system displays the Print dialog.

2. In the Print dialog, select the printer, print range, and number of 
copies.

3. If you need to specify any printer properties. click Properties and 
make your changes in the Document Properties window. Then 
click OK.

4. In the Print dialog box, click OK.

The system displays the Printing Properties window.
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5. Select any of the following print options:

● 1 to 1: The vector graphic will print as the size you see on your 
screen. This is the default option.

● fit to 1 page: The vector graphic will print on one page.

● fit to pages wide: The vector graphic will print on the number 
of pages you specify in the pages field. The printed graphic will 
remain height and width proportional.

● fit to pages high: Your vector graphic will print on the number 
of pages you specify in the pages field. The printed graphic will 
remain height and width proportional.

● scale to percent: The vector graphic will print to the size you 
specify in the % field. The printed graphic will remain height 
and width proportional.

● Step Labels: Click to enable the printing of step labels that are 
present on your vector graphic. If there are no step labels, this 
field is unavailable.

● Floating Comments: Click to enable the printing of global 
comments that are present on your vector graphic. If there are 
no global comments, this field is unavailable.

● Step Comments: Click to enable the printing of step comments 
that are present on your vector graphic. If there are no step 
comments, this field is unavailable.

● Alignment: Click the down arrow to select the positioning of 
the vector graphic on the printout.

6. Click OK in the Printing Properties window to print your vector 
graphic.
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Using the VDN Assignment Wizard

When the switch receives a call, it translates digits dialed by the caller 
or sent to it into a VDN. The switch uses VDNs to direct those calls to 
the appropriate vector. When your vectors are complete and ready to 
use, the VDN Assignment Wizard helps you assign VDNs to your 
vectors so that incoming calls are treated appropriately for the needs of 
your organization. 

Assigning VDNs to a vector
To assign VDNs to a vector:

1. To start the VDN Assignment Wizard, do either of the following

● Click the VDN Assignment Wizard button on the Framework 
toolbar.

● Select: Tools > VDN Assignment Wizard. 

The Welcome window is displayed.

2. In the Welcome window, browse your ACDs to find one that has 
one or more VDNs that you want to associate with the vector. 

Note:
If you are not connected to a server, you must double-click the 
server and complete the Connect to server dialog before you 
can view ACDs. Only ACDs that you have permission to view 
are displayed.

3. Select an ACD and click Next. 

The Available for Selection dialog is displayed.

In the Available for Selection dialog box, you can display a list of 
all VDNs available for selection, or you can filter the list to display 
only those VDNs containing certain criteria.

For information about the search filter, see Using Visual Vectors 
search filters on page 56.

4. To select the VDNs you want to administer in the Available for 
Selection: list, use either of the following methods:

● Highlight each of the VDNs that you want and then use the 
arrow buttons to move the VDNs in the Available for 
Selection: list box to the Selected: list box. 
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● Select the arrow button with the horizontal line under it (that is, 
the left-most arrow button) to move all VDNs in the Available 
for Selection: list box to the Selected: list box.

The following figure explains arrow button functions in the 
dialog. 

5. After you have moved the VDNs to the Selected: box, click Next.

The next window shows the VDNs you have selected and asks 
you to confirm the selection.

6. Do one of the following:

● If the selections are not correct, click Back to return to the 
previous window, where you can select the VDNs you want.

● If the selections are correct, click Edit to go forward.

The Properties dialog is displayed. In the Properties dialog, you 
identify the vector to which you are assigning the VDNs.
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7. Select the Vector name from the Vector Id: drop-down list.

Note:
If the ACD uses the Expert Agent Selection (EAS) feature, you 
can also change the skill preferences for the selected VDN.

8. If EAS is enabled on the switch, select one or more skill 
preferences from the Skill Preferences drop-down list, and click 
OK.

The VDN is now assigned to the vector you selected. 
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Using the Import Export Wizard

The Visual Vectors Import Export feature allows you to create a vector 
and export it to a public directory or other application, where the vector 
can be imported and shared by other users.

Basic Import Export Wizard functions
With the Import Export feature, you can:

● Share vectors within a single site or across a multi-site environment

● Create a central library of vectors that other users can access

● Archive vectors to a server on a LAN for backup

● Train and mentor other users

Exporting vectors
To export vectors:

1. Do one of the following:

● Click the Import Export Wizard button on the Framework 
toolbar.

● In Navigator, right click on the vector or vectors you want to 
export. Then select Export from the context menu. 

The Welcome window is displayed.

2. Select Export and then click Next. 

The next window displays a window to let you browse objects in 
the My World directory of call center objects.

3. Browse your available ACDs or ScratchPad folders to find the 
vectors that you want to export. Only ACDs that you have 
permission to view are displayed.

Note:
If you are not connected to a server, you must double-click the 
server and complete the Connect to server dialog before you 
can view its ACDs.
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4. Highlight the appropriate ACD and click Next. 

The Available for Selection list is displayed in the next window of 
the Wizard.

In the Available for Selection dialog box, you can display a list of 
all vectors available for selection, or you can filter the list to 
display only those vectors that contain certain criteria.

For more information about using the search filter, see Using 
Visual Vectors search filters on page 56.

5. To select the vectors you want to administer in the Available for 
Selection: list, use either of the following methods:

● Highlight each of the vectors that you want and then use the 
arrow buttons to move the vectors in the Available for 
Selection: list box to the Selected: list box.

● Select the arrow button with the horizontal line under it (that is, 
the left-most arrow button) to move all vectors in the Available 
for Selection: list box to the Selected: list box.
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Example: The following window illustrates the purpose of the arrows.

6. After you have moved the vectors to the Selected: box, click 
Next. 

The system displays the Archive File dialog.

7. Click Browse to display the Select Export Archive window, and 
find the target file on the network where you want to export the 
files.

8. When you find the archive file, click Save, and then click Next in 
the Archive File window.
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9. The dialog box that is displayed depends on whether or not the 
archive file you chose already exists in the destination folder. Do 
one of the following:

● If the file already exists, the system displays a dialog box that 
gives you the opportunity to specify how you want to handle the 
files. Continue with Step 10.

● If the file does not exist, the Export Summary window is 
displayed. Go to Step 12.

10. If the file already exists, you are prompted to do one of following:

● Do not overwrite duplicates

● Overwrite duplicates

● Replace the entire content of the file

11. Click Next. 

● If the file is corrupt or is an invalid format, the system displays 
an error message.

● If the file is not corrupt and is of valid format, the Vector Export 
Summary window is displayed. This window summarizes the 
information collected to perform the export action.

12. In the Vector Export Summary window, do one of the following:

● To cancel the export process, click Cancel.

● If you need to modify the values, click Back to go to previous 
windows.

● If you are satisfied with your choices, click Export. 

An Export Completed message is displayed.
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Using Visual Vectors search filters

The Visual Vectors VDN Assignment Wizard and Import Export Wizard 
include a search filter that allows you to filter VDNs according to 
various search criteria

To use the search filter:

1. In the Filter: field enter the desired alphanumeric characters, 
including wildcards. For example, you would enter:

● Question mark (?) for one character

● Asterisk (*) for any number of characters

For example, if you filter on the term *Adv*, your search would 
return VDNs with names like:

● RadioAdvertising

● AdventureTours

● AdvertisingDept

Alternately, if you excluded the leading asterisk character from the 
term to search on the term Adv*, you would generate a list of VDN 
names that begin with the letters Adv. In this example, the VDN 
named RadioAdvertising would be excluded from the search 
results.
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